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Opening and Viewing Presentations 
 

FIRST STEPS WITH PRESENTATIONS 
 

Opening PowerPoint 
 Click on the Start button (bottom-left of your screen).  From the popup menu 

displayed click on All Programs.  Click on a submenu option called Microsoft 
Office.  Finally click on Microsoft Office PowerPoint 2007. 
 

 
 
NOTE: The location of the PowerPoint option may vary slightly from one computer to 
another, but with a little searching around you should be able to find it! 
 
Clicking on the PowerPoint option will load the PowerPoint program from your hard 
disk into your computer memory (RAM – Random Access Memory). 
 
Your screen will look something like this. 
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Opening a presentation 
 To open a file, click on the Office Button (top-left of your screen) and then select 

the Open command. 
 

 
 
TIP: A shortcut to open a file is Ctrl+O. 
 
You will see the Open dialog box displayed.  Normally it will display the contents of a 
folder called My Documents. 
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 You need to navigate to the folder containing your sample workbook files. 

 Select a file called Computer Parts.  Open this file.  Your screen should now look 
like this. 
 

 
 

Navigating between slides 
 To move to the next slide press the Page Down key.  Press the Page Up key to  

display the previous slide.   
 
If you prefer using the mouse click on the Next Slide or Previous Slide controls 
located at the bottom of the vertical scroll bar. 
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 To display a particular slide, use the scroll bars to display the slide thumbnails 
(displayed down the left side of the screen) and then click on the thumbnail.   

 Experiment with displaying different slides. 
 Before continuing, return to the first slide.  
 

Using the Zoom tool 
 The Zoom controls are displayed at the bottom-right of your screen.  You can use 

the horizontal slider control to set the zoom level.  The larger the zoom level the 
greater the slide will be magnified on your screen. 
 

 
 

 If you click on the Zoom percentage figure (70% in the illustration), you will see the 
Zoom dialog box.  This allows you to select a range of preset options, or to set an 
exact zoom percentage. 
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Changing PowerPoint views 
 There are a set of view buttons in the Status bar at the bottom of your screen. 

 

 
 

 NORMAL VIEW :  
The first view icon is called the Normal view.  This is the view you normally work in.  
You see the slide thumbnails displayed to the left and the selected slide displayed to 
the right. 
 

 
 

 Slide Sorter view:  
Click on this icon and the screen will change as illustrated.  This view allows you to 
easily rearrange the order of slides within a presentation. 
 

 
 
Experiment with rearranging the order of the slides.  To do this, select a slide in 
Slide Sorter view.  Press the mouse button down and while keeping it depressed 
down move the mouse pointer to a gap between two other slides.  When you release 
the mouse button the slides will have changed position within the presentation. 
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 Slide Show View:  
Select the first slide within the presentation and then click on this icon.  The slide will 
be displayed as a slide show and fill the whole screen.  Click on the mouse button to 
advance through the slide show.  To stop the slide show at any point, press the Esc 
key. 
 

 
 

 Before continuing, make sure that you are displaying the presentation in Normal 
view. 

 

Using Help 
 To display the Help windows click on the Microsoft Office PowerPoint Help button 

at the top-right of the screen. 
 

 
 
TIP: To display the Help windows you can press the F1 keyboard shortcut. 
 
This will display the PowerPoint Help window. 
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Saving a presentation 
 To save the changes you have made to the presentation, use the Ctrl+S keyboard 

shortcut or click on the Microsoft Office button (top-left of the screen), and then 
select the Save command. 
SAMPLE



PowerPoint 2007 Foundation - Page 13 

FOR USE AT THE LICENSED SITE(S) ONLY 
 Cheltenham Courseware Pty. Ltd. 1995-2010 www.cheltenhamcourseware.com 

 

 
 

Closing a presentation 
 To close the presentation click on the Microsoft Office button (top-left of your 

screen) and then click on the Close command. 
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Closing PowerPoint 
 To close the PowerPoint program, click on the Close icon (top-right) of your screen. 

 

 
 

Opening multiple presentations 
 Restart PowerPoint. 

 You can open more than one PowerPoint presentation at a time.  Press Ctrl+O and 
open a presentation (it does not matter which one).  Then open a second and then a 
third presentation. 

 

Switching between multiple presentations 
 The different presentations will each be represented by a button in the Windows 

Taskbar across the bottom of your screen.  Clicking on a button displays the 
presentation represented by that button. 
 
 
 

 If you have many open presentations, you may see a single button, as illustrated 
below. Clicking on the button will display a list of open presentations and you can 
click on the one you wish to switch to. 
 

        
 
 
TIP: Pressing Alt+Tab allows you to switch between open presentations that are 
running. 
 

 Close all presentations and close PowerPoint. 
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Creating a Presentation 
 

Creating a Presentation 
 

Creating a new presentation 
 Start PowerPoint.  You will see a screen as illustrated. 

 

 
 

 Most presentations start with a title page and this is what you are viewing on your 
screen.  Click within the area of the slide displaying the message 'Click to add title'.  
You will see a title placeholder outlined, as illustrated below. 
 

 
 

 You can now type in a title for your presentation.  In this case type in the word 
'Computers', as illustrated. 
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 Next click within the area of the slide displaying the message 'Click to add a 
subtitle'.  You will see a subtitle placeholder outlined, as illustrated below. 
 

 
 

 Type in your name as a subtitle, in the example illustrated the name David Murray 
was entered. 
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Inserting a new slide 
 We have finished creating our title slide, next we need to insert a new slide so that 

we can start creating the rest of the presentation.  To do this, if necessary, click on 
the Home tab, and you will see the New Slide button displayed in the Ribbon. 
 

 
 
NOTE: There are two parts to this button.  Try clicking on the upper part of this 
button, i.e. the part that contains an icon picture that represents a new slide (we will 
see the effect of clicking on the lower part of this button later). 
 

 
 
A new slide is displayed, as illustrated. 
 

 
 
NOTE: You can now see two 'slide thumbnails' displayed to the left of your screen.  
The layout of the slide that you have just inserted is different.  There is no sense in 
having two 'Title' slides in one presentation.   
 

 Click within the area of the slide displaying the instruction 'Click to add title'. Type 
in the title for this slide, in this case type in the words 'System Unit '.  

 Click within the area of the slide displaying the instruction 'Click to add text'. Type 
in the text for this slide, in this case type in the words: 
 
The main PC box which houses the various elements which go together to 
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make up the PC. 
 

 Press the Enter key to drop you down to the next line.  Notice that a bullet point is 
automatically inserted for you.  Type in the following information to make up the 
second bullet point. 
 
Contains items such as the computer memory, hard disk and DVD drives. 
 
Your slide will now look like this. 
 

 
 

 This slide is now complete and you can insert your next slide.  Create the following 
slides within your presentation. 
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Undo and Redo 
 When creating or editing a PowerPoint presentation always remember that if you 

make a mistake, in most cases you can click on the Undo icon and undo the 
mistake.  The Undo icon is displayed at the top-left of your screen. 

 Try selecting a word within a slide and then pressing the Del key to delete it.  Then 
click on the Undo icon to undo the deletion. 
 

 
 
NOTE: You cannot undo a mistake after you have saved and closed a file. 
 
TIP: As well as Undo there is a Repeat icon to repeat the last action for you. 
 

 
 

Saving a presentation 
 You have created your first presentation.  You now need to save this presentation to 

your hard disk.  To do this click on the Save icon towards the top-left of your screen. 
 

 
 

 You will see the Save As dialog box displayed, similar to the illustration below. 
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 Click on the Down arrow to the right of the Save in section of the dialog box and 
navigate to the folder containing your sample files. 

 Notice that the file name suggested by PowerPoint in the File name section of the 
dialog box is Computers.  This name is taken from the title you typed into your first 
slide.  Click on the Save button to save the presentation to your disk. 
 
TIP: Now that you have named your presentation, in future clicking on the Save icon 
will not ask you for a file name, but will automatically use the existing file name and 
overwrite the contents of the version of the presentation that you have saved on 
disk. 

 

Saving a presentation using a different name 
 Sometimes you may like to have different versions of a presentation saved on disk.  

To save the presentation using a different file name, click on the Office Button (top-
left or your screen) and from the options displayed click on the Save As button.   
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TIP: If you look closely at the Save As button, it is made up of two components.  The 
disk icon and the words Save As make up one part, while the right pointing arrow 
makes up the other part.  Be sure to click on the disk icon for now.  This will display 
the Save As dialog box.  Within the File name section of the dialog box, enter a new 
name such as My First Presentation.  Click on the Save button to save the 
presentation.  
 
You now have two copies of the presentation saved to disk.  The first one is saved 
as a file called Computers, while the second copy is saved as a file called My First 
Presentation. 
 

 Close your presentation and close PowerPoint. 
 

Manipulating Slides 
 

Inserting slides with a particular slide layout 
 Start PowerPoint and open the presentation called Manipulating Slides. 
 Display the last slide within the presentation. 

 Click on the bottom part of the New Slide button (the part displaying the text New 
Slide). 
 

 
 
This will display a drop down allowing you to select the type of slide layout that you 
wish to insert.  Select the Two Content option as illustrated. 
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 Your screen will now look like this: 
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 Click within the title area of the slide and insert the following title. 
 
Laptop Computers 
 
 

 Click within the left 'Add text' area and add the following text. 
 
All the computer components are contained within a single unit. 
 

 Click within the right 'Add text ' area and add the following three lines of text. 
 
Portable 
Flexible 
Normally more expensive than desktop computers 

 

Modifying the slide layout 
 Display the slide displaying information about the Keyboard. 

 Within the Home tab, click on the Layout button. 
 

 
 

 From the drop down options select Two Content.  
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The layout will change as illustrated. 
 

 
 
 

 You can click within the right hand text area and add more text such as: 
 
Many different types of keyboard are now available. 

 

Changing the background color on the active slide 
 Make sure that the slide relating to the keyboard is displayed. 

 Click on the Design tab and then click on the Background Dialog Box Launcher 
button. 
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This will display the Format Background dialog box. 
 

 
 

 Click on the down arrow to the right of the Color section.  This will display a drop 
down from which you can select a color.  Select a light blue color. 
 

 
 

 Click on the Close button. 
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 As you can see from looking at the left of your screen, this color has only been 
applied to the active slide. 
 

 
 

 Scroll up and down through your presentation to confirm that only the slide relating 
to the Keyboard has a light blue background. 

 

Changing background color on all the slides within a 
presentation 
 Click on the Design tab and then click on the Background Dialog Box Launcher 

button. 
 

 
 
This will display the Format Background dialog box. 
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 Click on the down arrow to the right of the Color section.  This will display a drop 
down from which you can select a color.  This time select a light red color. 
 

 
 

 Click on the  Apply to All button. 
 

 
 

 Click on the Close button to close the dialog box. As you can see from looking at the 
left of your screen all the slides now have a light red background. 
 

SAMPLE



PowerPoint 2007 Foundation - Page 30 

FOR USE AT THE LICENSED SITE(S) ONLY 
 Cheltenham Courseware Pty. Ltd. 1995-2010 www.cheltenhamcourseware.com 

 
 

 Save your changes and close the presentation. 
 

Themes 
 

Applying a theme to a presentation 
 Open a presentation called Designs. 

 Click on the Design Tab. 

 Click on the down arrow to the right of the Themes section. 
 

 
This will display a drop down from which you select a design type.  In this case 
select the Module design. 
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 Once you click on a design it will be applied to all your slides, as illustrated. 
 

 
 
As you can see with very little effort your slides suddenly look much more 
interesting! 
 

 Experiment with applying other designs to your presentation slides. 
 

Text Boxes (Placeholders) 
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What are Text Boxes (Placeholders)? 
 Display the first slide within your presentation. 

 Select the text Cheltenham Courseware and replace it with your name. 
 Click once on your name and you will see the placeholder for your name, as 

illustrated. 
 

 
 

 Click on the presentation title and you will see the title placeholder, as illustrated. 
 

 
 

 These placeholders determine where the text will be displayed on the slide.  You can 
move or resize any placeholder within a presentation.   
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Resizing a Text Box (Placeholder) 
 Click on the placeholder containing your name.  Move the mouse pointer over the 

'handle' in the middle of the top edge of the placeholder.  Press the mouse button 
and while keeping it pressed move the mouse pointer up the slide.  When you 
release the mouse button the placeholder will be resized so that it is taller.  Try 
resizing this placeholder so that it is shorter.   

 Use the same technique on either side of the placeholder to make the placeholder 
narrower or wider.  In this case you will need to drag the handle on either vertical 
side of the place holder. 

 Try moving the mouse pointer to one of the four placeholder corners and you will be 
able to drag to resize the placeholder in two directions at the same time, allowing 
you to make the placeholder narrower or wider and also taller or shorter. 

 Experiment with resizing the placeholder containing the title. 

 Before continuing resize both placeholders to their approximate original sizes. 
 

Moving a Text Box (Placeholder) 
 Click on the placeholder containing your name.  Move the mouse pointer over the 

dotted line representing the placeholder (not over a handle).  The shape of the 
mouse pointer will change.  Press the mouse button and while keeping the button 
pressed move the mouse pointer up the screen.  When you release the mouse 
button the name placeholder will be displayed higher up on your slide. 
 

 
 

 Use the same technique to move the title placeholder down and to the left on your 
slide. 

 Save your presentation and close PowerPoint 
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Text editing and formatting 
 

Selecting, copying moving, resizing and deleting text 
 

Selecting text 
 Open a presentation called Manipulating text. Display the second slide displaying 

information about the 'System Unit' 

 To select a word on the slide double click on that word.  Try double clicking on the 
word 'box'.  You will then see this word highlighted indicating that it has been 
selected. 
 

 
 

 To select a number of words within a paragraph, click before the first word that you 
wish to select and hold the Shift key down.  While keeping the Shift key pressed 
click just after the last word that you wish to select.  Release the Shift key and the 
text will remain selected, as illustrated.  Try this now. 
 

 
 

 To select an entire paragraph, triple click within that paragraph.  Try triple clicking 
within the second paragraph and you will see the following. 
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Moving text within a slide 
 Display the slide relating to the Screen. 

 Select the first bulleted paragraph.  Press Ctrl+X to Cut the selected text to the 
Clipboard. 

 Click at the end of the last bulleted point and press the Enter key to insert a new 
bullet point. 

 Press Ctrl+V to paste the contents of the Clipboard to the insertion point. 
 

Moving text between slides within a presentation or between 
presentations 
 Display the slide with the title 'Hard Disk'. 
 Select the last two bulleted paragraphs. Press Ctrl+X to Cut the selected text to the 

Clipboard.  Display the next slide titled 'Internal Hard Disk'. 

 Click after the bulleted paragraph and press the Enter key. 
 Press Ctrl+V to paste the contents of the Clipboard to the insertion point. 

 
TIP: You can use the same method to move selected text to  a slide within a different 
presentation. 

 

Copying text within a slide 
 Display the slide relating to the Memory. 

 Select the first bulleted paragraph.  Press Ctrl+C to Copy the selected text to the 
Clipboard. 

 Click at the end of the last bulleted point and press the Enter key to insert a new 
bullet point. 

 Press Ctrl+V to paste the contents of the Clipboard to the insertion point. 
 

Copying text between slides within a presentation or 
between presentations 
 Display the slide with the title 'System of Mother board'. 

 Select the last two bulleted paragraphs. Press Ctrl+C to Copy the selected text to 
the Clipboard.  Display the slide titled 'System Unit '. 

 Click after the last bulleted paragraph and press the Enter key. 

 Press Ctrl+V to paste the contents of the Clipboard to the insertion point. 
 
TIP: You can use the same method to copy selected text to a slide within a different 
presentation. 
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Deleting text 
 Practice selecting a word, sentence or paragraph and deleting the selected text by 

pressing the Del key. 
 

 Save your changes and close the presentation. 
 

Searching Your Presentation 
 

Using Find 
 Open a presentation called Find and Replace. 

 Click the Find button, located in the Editing group of the Home tab. 
 

 
 
TIP: Use the Ctrl+F keyboard shortcut to start the Find function. 
 

 The Find dialog box will be displayed.  Type the word computer into the Find what 
box. 
 

 
 

 Click on the Find Next button.  PowerPoint will locate and select the first instance of 
the word computer in the presentation.  Click on the Find Next button repeatedly to 
find all occurrences of the word. 

 When you reach the end of the search PowerPoint will display the following dialog 
box. 
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 Click on the OK button. 

 Click on the Close button within the Find dialog box. 
 

Using Replace 
 Click the Replace button, located in the Editing group of the Home tab. 

 

 
 
TIP: Use the Ctrl+H keyboard shortcut to start the Replace function. 
 

 The Replace dialog box will be displayed.  Type the word computer into the Find 
what box. 

 Type the word PC into the Replace with box.  The Replace dialog box should now 
look like the illustration below. 
 

 
 

 Click on the Find Next button.  PowerPoint will locate and select the first instance of 
the word computer in the presentation.  To replace that instance of the word 
computer with PC click on the Replace button.  Repeat this process to replace all 
occurrences of the word computer with PC. 

 When you reach the end of the search PowerPoint will display the following dialog 
box. 
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 Click on the OK button. 

 Click on the Close button within the Replace dialog box. 
 

 Save your changes and close the presentation. 
 

Font Formatting 
 

Font formatting options 
 Open a presentation called Font formatting. 

 Select the first paragraph of text within the 'System Unit' slide. 

 Make sure that the Home tab is displayed and you will see the following icons 
relating to basic text formatting. 
 

 
 

Changing the font type 
 Select the first paragraph of text.  Click on the down arrow to the right of the Font 

section of the Ribbon.  This will display a drop down from which you can select the 
required font.  Apply the Arial font, as illustrated. SAMPLE
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Changing font size 
 Select the first paragraph.  Click on the down arrow to the right of the Font Size 

section.  Experiment with applying different font sizes. 
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Increasing or decreasing the font size 
 Select the text within the slide title.  Experiment with using the Increase Font Size 

and the Decrease Font Size icons. 
 

 
 
TIP: The shortcut to increase the font size of selected text is Ctrl+] 
The shortcut to decrease the font size of selected text is Ctrl+[ 
 
Be sure that you use the square open and close brackets. 

 

Bold, Italic or Underline formatting 
 Select the title text and experiment with applying bold, underling and italic formatting.   

 

 
 
TIP: After selecting text clicking on one of these icons applies the effect, while 
clicking on the icon a second time removes the effect. 
 
TIP: You can use keyboard shortcuts to format text as bold, italic or underlined. 
 
Bold  Ctrl+B 
Italic  Ctrl+I 
Underlined Ctrl+U 
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Strikethrough effects 
 Select a word and experiment with applying strikethrough formatting using the 

Strikethrough icon. 
 

 
 

Shadow effects 
 Select a word within the last paragraph and experiment with applying Shadow 

formatting.  You may find this effect is easier to see when combined with Bold 
formatting. 
 

 
 

Character spacing 
 Display the slide relating to the CPU. 

 Select the first paragraph. 
 Click on the Character Spacing icon.  This will display a drop down from which you 

select the required type of character spacing.  Experiment with applying different 
types of character spacing and observe the effects. 
 

 
 

 Reset the character spacing back to 'Normal' before continuing. 
 

Changing case 
 Display the slide relating to the mouse. 
 Select the title text on your slide. 
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 Click on the Change Case icon.  This will display a drop down from which you can 
select how you wish to change the case of the selected text. 

 Experiment with applying the different options available and observe the effect of 
your changes. 
 

 
 

Font color 
 Select the last paragraph of text within your slide. 

 Click on the down arrow to the right of the Font Color icon.  This will display a 
range of colors that you can apply to the selected text. 
 

 
 

 Experiment with applying different colors to entire paragraphs within your 
presentation and also to individual words within a slide. 

 

Clearing all text formatting 
 Select a paragraph of text that you have previously formatted.  Click on the Clear All 

Formatting icon and the formatting will be removed. 
 

 
 

 Save your changes and close the presentation. 
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Paragraph Formatting  
 

Text alignment 
 Open a presentation called Paragraph formatting. 
 Display the second slide.  Click within the last paragraph within the slide. 

 Experiment with clicking on the alignment icons to align to the left, to the right and 
centering the text.  Also examine the effect of the clicking on the Justify button. 
 

 
 

Columns 
 Display the last slide within your presentation. 

 Click within the text area and then click on the Columns icon.  You will see a drop 
down offering you various column formatting choices.  Experiment with applying two 
then three column formatting to your text. 
 

 
 

 If you have time experiment with clicking on the More Columns option which 
displays the Columns dialog box. 
 

 
 
You can use this dialog box to set the number of columns and the spacing between 
the columns. 
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Modifying bullet point formatting 
 Select the three bulleted paragraphs within your last slide. 

 Click on the down arrow to the right of the Bullets icon to display a drop down list 
of alternative bullet symbols.  Experiment with applying different types of bullets to 
the slide. 
 

 
 

Using numbering instead of bullet points 
 Display the slide relating to the 'System or Mother board'. 

 Select the three bulleted paragraphs within this slide. 
 Click on the down arrow to the right of the Numbering icon to display a drop down 

list of alternative numbering formats.  Experiment with applying different types of 
numbering to the slide. 
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Changing the list level 
 Display the slide relating to the 'Memory'. 

 Click within the last paragraph within the slide. 
 Click on the Increase List Level icon. 

 

 
 
Your slide will change to look like this.   
 

 
 
As you can see the last paragraph has been indented to the right and the text is 
displayed using a smaller font.  You can use the Decrease List Level icon to 
reverse the effect. 
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Line spacing 
 Display the slide relating to the 'Screen'. 

 Select the two bulleted paragraphs. Click on the Line Spacing icon.  This will 
display a drop down from which you can modify the line spacing.  Experiment with 
this applying these effects. 
 

 
 

 Save your changes and close the presentation 
 

Using Outline view 
 Open a presentation called Outline view. 

 Click on the Outline view tab. 
 

 
 

 The screen will now look something like this. 
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 The outline view, as the name implies lets you view your presentation as an outline.  
You are not distracted by the formatting and layout and can concentrate on the 
content and structure of the presentation. 

 You can add or delete text within the outline view.  As an example look at the details 
of the 'System Unit' slide in outline view. 
 

 
 

 Click after the word 'PC'.  Press the Enter key.  Type in the following paragraph of 
text.   
 
'The power cable, mouse and keyboard cables plug into the back of the 
system unit' 
 

 As you will see the slide displayed this new bulleted paragraph in the normal way.  
The additional text is also displayed in the outline.   
 
TIP: When you are first creating a presentation consider creating the basic structure 
using outline view, so that you can concentrate on content and structure of the 
presentation.  Formatting the presentation, as we have seen is easy and comes 
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later.  The most important part of any good presentation is the content. 
 

 Experiment with editing words, sentences and paragraphs within outline view. 
 Save your changes and close the file. 
 

PowerPoint Notes 
 Open a presentation called Notes. 
 If you look carefully at your screen you will see a section towards the bottom 

displaying the message 'Click to add notes' 
 

 
 
You can use this area to add presenter notes to a presentation.  These can be used 
as memory aids and prompts by the presenter, but are not designed to be seen by 
persons viewing the presentation. Add the following notes to the title page. 
 
Remember to point out that these days many people use laptops, where all the 
various parts of a computer are housed within a single box. 
 

 Experiment with adding notes to some of the other slides within the presentation 
(just make up some information). 

 Save your changes and close the presentation. 
 

Text direction 
 Open a presentation called Text direction. 

 Click on the word 'Computers' within the first slide. 

 Click on the Home tab and within the Paragraph section click on the Text Direction 
icon.  This will display a drop down list of text direction options. 
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 Select the Rotate all text 90° option.  Your slide will now look like this. 
 

 
 

 Experiment with applying other Text Direction options to the rest of the slides within 
your presentation. 

 Save your changes and close the file. 
 

Text alignment within a Text Box (placeholder) 
 Open a presentation called Text alignment. This presentation only contains one 

slide for you to practice modifying the alignment of text within a Text Box 
(placeholder). 
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 Click within the body text and then click on the Align Text icon (Located within the 
Paragraph group of the Home tab). This will display a drop list of options.  
Experiment with applying the Top, Middle and Bottom options and observe the 
effect. 
 

 
 

 If you have time investigate the options available when you click on the More 
Options command.  This will display a dialog box allowing additional formatting of 
the Text Box (placeholder). 
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TIP: You can click on the question mark icon at the top-right of the dialog box to 
display information about what each of these options does. 
 

 
 

 Save your changes and close the presentation. 
 

Text Autofit 
 Open a new blank presentation. 
 Click within either of the placeholders and type a few paragraphs of text.  You will 

see that as your text starts to fill the placeholder, by default, PowerPoint will reduce 
the size of the font to keep your text within the boundary of the placeholder. 

 Right click on your text and from the menu displayed select Format Text Effects. 
 

 
 

 The Format Text Effects dialog box will be displayed.  The Autofit  section of dialog 
box allows you to control this behavior.  Try selecting Do not Autofit and observe 
the effects. 
 

 
 

 Close the Format Text Effects dialog box by click on the Close button. 
 

 Close your presentation without saving your changes. 
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Using the Format Painter 
 Open a presentation called Format painter. 

 Display the second slide. Select both bulleted paragraphs within this slide and apply 
text formatting effects, such as changing the font type, color and size. 

 Once you have applied these text formatting modifications, select the text that you 
have just formatted and then click on the Format Painter icon (contained within the 
Clipboard group of the Home tab).  The shape of the mouse pointer will change to 
that of a paint brush. 
 

 
 

 Display another slide within the presentation and then click at the end of a paragraph 
and while keeping the mouse button depressed move the mouse pointer up to the 
start of the paragraph.  When you release the mouse button the text formatting 
characteristics of the original paragraph will be applied to the current paragraph. 
 
TIP: If you single click on the Format Painter icon, then the format painting effect of 
dragging across a portion of text will only once work once.   
 
If however you double click on the Format Painter icon, the effect will remain active 
until you press the Esc key to turn the effect off.  You can use this trick to apply the 
formatting from one portion of text to many portions of text throughout the 
presentation.  Try experimenting with using this trick now. 
 

 Save your changes and close the presentation. 
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Illustrations 
 

Selecting, copying moving, resizing and deleting Illustrations 
 

Selecting an illustration 
 Open a presentation called Manipulating illustrations 1.  Display the second slide 

which contains four illustrations.  To select an illustration click on the illustration.  For 
example click on the Elephant and it will look like this.  The eight small squares 
around the selected border are called 'handles' and as we will see, they can be used 
to re-size the illustration. 
 

 
 

 Click on each of the illustration, one by one, to practice selecting illustrations. 
 
TIP: Sometimes you may need to select more than one illustration.  Click on the 
Elephant illustration to select it.  Press the Ctrl key (and keep it held down).  Click 
on the Monkey illustration and then click on the Bird illustration.  Let go of the Ctrl 
key.  All three illustrations will remain selected, as illustrated.  Try this now. 
 

 
 

Moving an illustration 
 Display the slide titled 'Picture'.  Select the illustration.  Move the mouse pointer 

over the illustration and press the mouse button (and keep it pressed).  Move the 
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mouse pointer to a different position on your slide.  When you release the mouse 
button the illustration will have moved. 

 

Copying an illustration 
 Select the illustration.  Press down the Ctrl key, and keep it depressed. Move the 

mouse pointer over the illustration and press the mouse button (and keep it 
pressed).  Move the mouse pointer to a different position on your slide.  When you 
release the mouse button and the Ctrl key the illustration will have been copied, as 
illustrated. 
 

 
 

Deleting an illustration 
 Select the illustration that you have just copied.  Press the Del key and the selected 

illustration will be deleted. 
 

Resizing an illustration 
 Select the illustration.  Move the mouse pointer to one of the four corner handles.  

Press the mouse button and keep it depressed.  Move diagonally outwards from the 
centre of the illustration to make the illustration larger, or move towards the centre of 
the illustration to make the illustration smaller.  When you release the mouse button 
the illustration will remain resized. 

 

Stretching an illustration 
 Select the illustration.  Move the mouse pointer to one of the four handles at the 

centre of each border.  Press the mouse button and keep it depressed.   

 If you selected a handle on one of the vertical borders move the mouse left or right 
to stretch the illustration. 
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 If you selected a handle on one of the horizontal borders move the mouse up or 
down to stretch the illustration. 
 

 
 
TIP: If you accidentally stretch an illustration when you meant to just resize an 
image, you can always click on the Undo icon to reverse the accident. 
 

 We have been manipulating a picture illustration.  Use the same techniques to 
manipulate the illustrations in the rest of the presentation.  These illustrations include 
Clip Art, Shapes, SmartArt and a chart. 

 

Copying illustrations between presentations 
 Select an illustration within your presentation and press Ctrl+C to copy the selected 

illustration to the Clipboard. 

 Open a presentation called Manipulating illustrations 2.   
 Display the second slide. 

 Press Ctrl+V to paste the illustration that you copied to the Clipboard into this Slide.  
You have now copied the illustration from one presentation to another.  

 You may want to reposition and resize the illustration within this slide. 
 

Moving illustrations between presentations 
 Display the contents of the presentation called  

Manipulating illustrations 1.   
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 Select an illustration within your presentation and press Ctrl+X to cut the selected 
illustration to the Clipboard. 

 Switch to the presentation called Manipulating illustrations 2.   
 

 Display the second slide. 
 Press Ctrl+V to paste the illustration that you cut to the Clipboard into this Slide.  

You may want to reposition and resize the illustration within this slide.  You have 
now moved the illustration from one presentation to another. 

 
 Save your changes and close the files. 
 

Inserting Illustrations 
 

Inserting Illustrations within PowerPoint 
 If you click on the Insert tab you will see an Illustrations group, which allows you to 

insert different types of illustration, as shown below. 
 

 
 

Inserting pictures 
 Open a presentation called Illustrations.   
 Display the first slide. 

 Click on the Picture icon (contained within the Illustrations group of the Insert tab).  
This will display the Insert Picture dialog box. 

 You will probably find that by default the Insert Picture dialog box is displaying the 
contents of a folder called My Pictures. 
 

 
 

 Use the controls within the Look in of the dialog to view picture files within the folder 
containing your sample files. 

 Select a file called computer desk. Click on the Insert button to insert this picture 
into your slide. 
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 You may find that the picture needs to be moved.   
 

 
 

 To move a picture, or any other type of illustration, first click on the illustration to 
select it.  Then press the mouse button, and while keeping the mouse button 
pressed move the mouse pointer on the screen to drag the illustration to the desired 
location, as illustrated below. 
 

 
 

 If you need to resize an illustration, click once on the illustration to select it then click 
on a corner handle and drag to re-size the illustration. 

 

Inserting Clip Art 
 Display the slide relating to information about the Keyboard. 
 Click on the Clip Art icon (contained within the Illustrations group of the Insert 

tab).  This will display the Clip Art side panel to the right of your slide. 
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 In the Search for section type in the word 'Keyboard'.  Click on the Go button and 
after a short delay you will see keyboard related clip art displayed in the side panel. 
 

 
 

 You may need to scroll down the items of clip art to find the one you want.  Click on 
an item you wish to insert into the slide, then it will be inserted, as illustrated. 
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 You may want to re-size the clip art.  To do this click on the clip art within the slide 
and then click on one of the corner handles that are displayed. 
 

 
 

 Press the mouse button and while keeping it pressed, move the mouse away for the 
centre of the clip art.  The clip art will get bigger.  When you release the mouse 
button, the clip art will remain resized.  To make the clip art smaller, select the clip 
art and drag towards the centre of the clip art.  Your clip art will then look something 
like this. 
 

 
 
TIP: To move an item of clip art click once to select it, then press the mouse button.  
While keeping the mouse button pressed move the mouse pointer on your screen.  
When you release the mouse button the clip art will have moved to the new position 
on your slide. 

 

Inserting Shapes 
 Display the slide relating to the mouse. 
 Click on the Shapes icon (contained within the Illustrations group of the Insert tab).  

This will display a drop down from which you can select the required shape.   
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 In this case select the 7-Point star from the Star and Banners section of the drop 
down. 
 

 
 

 You will notice that the shape of the mouse pointer has changed.  Move the mouse 
pointer over an empty part of the slide.  Press the mouse button down (and keep it 
held down).  Move the mouse pointer diagonally across the screen and when you 
release the mouse button you will see the shape displayed on your screen, as 
illustrated. 
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Inserting text into a shape 
 Select the shape and click on the shape using the right mouse button. From the 

popup menu displayed select the Edit Text command. 
 

 
 

 If you look closely you will notice that the text insertion point is now within the shape.  
Type some text such as: 
 
Use a good mouse! 
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Your shape will now look like this: 
 

 
 

Inserting perfect circles or perfect squares 
 Display the slide relating to the CPU. 

 Insert an Oval shape (located within the Basic Shapes section of the Shapes drop 
down). 
 

 
 

 As you drag across the screen you will find that this shape is oval, not necessarily 
circular, and you may produce shapes as below. 
 

 
 

 If you wish to insert a perfect circle shape then you need to keep the Shift key 
pressed while dragging across the screen to insert the shape.  The circle will then 
look as below.  Experiment with inserting a perfect circle. Remember that you can 
always click on the Undo icon (top left of your screen) to undo any experimentation! 
 

 
 

 The same trick applies to creating a perfect square shape rather than a  rectangle.  
You can use the Rectangles section of the Shapes drop down to experiment with 
this. 
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 Save your changes and close the presentation. 
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End of the preview sample 
 
 

 
 
This sample is approximately half of the full course.  Please see the table of contents at 
the beginning of this document to see the full list of topics covered in the full course. 
 
To purchase the rights to use the full training manuals at your training centre please see 
our web site at:  
 

http://www.cheltenhamcourseware.com 
 
A courseware licence allows you to make unlimited copies for use at your training 
centre. 
 

 
 
In addition you get HTML formatted versions of each 
course, included with our printable courseware. 
 
Invest in a complete Computer Courseware 
Library, including Windows 7 & Office 2010 
The most cost effective courseware solution for your IT 
training needs. Get ALL our courses, and all new 
courses released within 12 months. 
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